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       INTODUCTION                                                                  
 

Rhinoceros is 3D modeling software that can be used in a variety 
of ways and for very different purposes. 
It is primarily a surface modeling tool, but has many related 

functions as well. Many users use only a small portion of what 

Rhino has to offer, while others need and use a lot more; it 

depends on what the individual user is trying to accomplish with 

the application. Even very experienced users can find new and 

useful tools of which they were previously unaware. In this 

introduction, a broad overview of various elements that you will 

encounter while using Rhino to get your work done is provided. 

.                                                                                                                                          

Course Objectives 
 

• Utilize the features of the Rhino user interface 
• Customize your modeling environment 
• Create basic graphic objects—lines, circles, arcs, curves, solids, 
and surfaces 
• Model with precision using coordinate input, object snaps, and 
Smart Track™ tools 
• Modify curves and surfaces with edit commands and Gumball 
• Use control point editing to modify curves and surfaces 
• Analyze your model 
• Display any portion of the model  

• Export and import models to and from different file formats 
• Render the model using Rhino Render 
• Dimension and annotate model with test and hatch 
• Use Layouts to arrange views of model on paper for printing 
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Why Rhinoceros is useful to Designing? 

When we make any product, first of all we need to design. If a product 

is made perfectly, what types of things shows that it is perfect, to prove 

it , it is necessary that its angle , dimension, and measurement should 

be perfect .A Design expresses its full Vertical and Horizontal sides as its 

length and width and its angle also. A big products design can be 

expressed on the paper and it would come in existence easily. 

 

For what purpose to learn Rhinoceros? 

 To learn the basic knowledge of designing.  

 How to design a product. 

 To understand of various products produced by different 

manufactured. 

 To draw the design according to the buyers demand. 

 To check the basic requirement to draw design. 

 To draw the design according to the given size. 

 To learn how to apply the different types of finishes. 

 To learn knowledge of units used in design. 
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WORKING WITH 3D MODELS 
 

With 3d modeling, you can design using solid, surface, and mesh models. 

Create new 3D solids and surfaces, or sweep, combine, and modify existing 

objects.  There are some solid based commands through which we can 

directly make solid object; there are some solid based command.  

 Create a Solid Box    

 Create a Solid Cone  

 Create a Solid Cylinder  

 Create a Solid Pyramid  

 Create a Solid Torus 

 Create a Solid Wedge     

 

There are some special commands that make 3d from 2d and can 

change the shape of object, now you can learn these commands. 
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Object types 
 

Rhino has tools to create and edit several different types of 
objects, of which surfaces are one. A surface in Rhino refers to an 
infinitely thin, infinitely flexible, mathematically defined digital 
membrane.     

                         

Surface 
Surfaces are represented on screen by 

Either some outline curves plus some 
Interior curves, called isocurves, or by a 
Shaded picture which makes a surface 
Appear to have some substance and to 

Show light and shading. 

 

Polysurface 
Rhino also has objects which consist of two or more 

surfaces joined together. 

 

Solid 
We have already said that surfaces are infinitely 
thin; they have zero thickness. 
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Curve 
Another object type that is related to a surface is a 

curve. In Rhino terminology, the word curve includes 

lines, polylines (think of these as series of straight line 

segments strung together end to end and joined), arcs, 

ellipses, circles, or free-form curves that are generally 

smooth. 

 

Lightweight Extrusion Objects 
Another object type that is related to a polysurface and a 

solid is 

the lightweight extrusion object. Lightweight extrusion 

objects 

use less memory, mesh faster, and save smaller than the 

traditional polysurfaces. 

Polygon Mesh 
Rhino also creates, edits, and otherwise uses polygon 

meshes. 

Polygon meshes are sometimes used to depict the 

same type of objects as 

surfaces but there are important differences. Polygon 

meshes consist of a 

number, sometimes a very large number, of points in 

space connected by 

straight lines. These straight lines form closed loops of 

three or four sides, 

that is, polygons. 
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To open Rhino: 
� Double-click the Rhino icon from the Windows desktop. 

The Rhino Screen 
Rhino divides its several areas that supply information or prompt 
you for input. 
Screen Area Description 

Menu Bar Access commands, options, and help. 
Command area Lists prompts, commands you enter, and 
information displayed by the command. 
Command 
history window 
Displays 500 lines of the most recently used commands. Activate 
this window with F2. 
Tabbed 
toolbars 
Groups are containers with one or more toolbars, with a tab at 
the top for each toolbar.  
Floating a toolbar makes single-toolbar group. 
Sidebars Access shortcuts to commands and options. Updates 
when selecting tabbed toolbar. 
Graphics area Displays the open model. Several viewports can be 

displayed. The default viewport layout displays four 
viewports (Top, Front, Right, and Perspective). 
Viewports Displays different views of the model within the 
graphics area. Viewports can show a grid, grid axes and world 
axes icon. 
Status bar Displays the coordinates of the pointer, the units and 
current layer of the model, toggles and other options. 
Panels Rhino controls like layers, properties, materials, lights, 
display mode and more are displayed in panels with 
tabs. 

Osnap bar Access running object snap settings. 
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Menus 
You can find most of the Rhino commands in the menus. 

 

 

 

Toolbars 
Rhino toolbars contain buttons that provide shortcuts 

to commands. 

Tooltips 
Tooltips tell what each button does. Move your pointer 

over a button without clicking it. A 

small yellow tag with the name of the command appears. 

Cascading toolbars 
A button on a toolbar may include other command 

buttons in a cascading toolbar. Usually the cascading 

toolbar contains variations on the base command. 

After you select a button on the cascading toolbar, the 

toolbar disappears. 

 
 

.Graphics Area 

The Rhino graphics area includes the viewports. You can 

customize the viewports and their position to suit your 

preferences. The position of viewports is adjustable. 

Viewports 
Viewports are windows in the graphics area that show you views 
of your model. To move and resize viewports, 
drag the viewport. 
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Command Area 
The command area displays commands and command prompts. 
You can dock the command line at the top or the 

bottom of the screen or it can float anywhere. 

 

Zooming in and out 
Sometimes you want to get closer to your objects or move back 

so you can see more. This is zooming. As with many things in 

Rhino, there are several ways to do this. 

 
 

 

 

 

 
Creating and Editing Geometry 
To draw line segments: 
 

1 From the Curve menu click Line, and then click Line 
Segments to begin 
the Lines command. 
2 Pick a point in a viewport. 
3 Pick another point in a viewport. Click p1 and drag the mouse 
click next point p2. 

A line segment appears between the two points. 

 

       P1                                     p2 
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To draw a polyline: 

 
1 Use the Undo command to undo the segments you just 
created. 
2 From the Curve menu click Polyline , and then click Polyline 
to begin the 
Polyline command. 
3 Pick a Start point and 3 or 4 more points. 
4 Press Enter when done. Click first point p1 , next click p2 then 
p3 and continuo p4,p5 . 
This makes an open polyline. A polyline is made of line segments 
that 

are joined together. It is one object. 

 

p1                        p2                   p4                                   p5 

      

                                   p3            

To draw a single line segment: 
1 From the Curve menu click Line, and then click Single 

Line to begin the 

Line command. 

2 Pick a Start point. 

3 Pick an End point. 

The command ends after one segment is drawn 
 
 
 
      P1                                        p2 
 

Drawing curves from control points 

1 From the Curve menu click Free-form, and then click Control 
Points. 
2 Pick a Start point. 
3 Continue picking points.     
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Notice that most of the points you pick are off the curve as 

control 

   P1 

                                 P3     

 

                    

Modeling aids 
Modeling aids are modes that you can toggle on or off by pressing 
shortcut keys, a function key, typing a single 

letter command, or clicking a button. 

Click the Grid Snap, Ortho, Planar, Gumball, SmartTrack or 
Record History panes on the status bar to 
Toggle these modeling aids on and off. 
Grid Snap 

This modeling aid constrains the marker to snap on grid 
intersections. 
You can also toggle Grid Snap on and off by pressing F9 or typing 
the letter S and pressing Enter. 
Pressing F7 hides or shows a reference grid in the current 
viewport of the graphics screen at the construction plane. 

Ortho 
This modeling aid constrains the marker movement to the points 
at a specified angle from the last point created. 
The default angle is 90 degrees. 
You can also toggle Ortho on and off by pressing F8 or pressing 
and holding the Shift key down. 

Osnap 
Object snaps constrain the marker to an exact location 

on an object such as the end of a line or the center of a 

circle. 
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SmartTrack 
This modeling aid uses temporary reference lines and 

points that are drawn in the Rhino viewport using implicit 

relationships among various 3-D points, other geometry 

in space, and the coordinate axes' directions. 

Planar 
This is a modeling aid similar to Ortho. This helps you model 
planar objects by constraining the input to be on a 
plane parallel to the construction plane that passes through the 

last point that you picked. 
You can also toggle Planar on and off by typing the letter P and 
pressing Enter. 

Gumball 
Displays a display widget, on a selected object, 

facilitating move, scale, and rotate transformations 

around the gumball origin. 
 

Record History 
Records history and updates history-aware objects. 

With History recording and Update turned on, a 
lofted surface, for example, can be changed by 
editing the input curves. 

In general, it is best to leave the Record option set 
to No and use the Record History status bar pane 
to selectively record history. Recording history 

uses computer resources and makes saved files 
larger 
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Filter 
This modeling aid restricts any selection mode to 

specified object types. Objects types that can be 

restricted are: 

Annotations, Blocks, Control points, Curves, Lights, 

Meshes, Point clouds, Points, Polysurfaces, Surfaces, 

Hatches, 

and others. 
 

 

Layers 
 

Rhino layers work like CAD layering systems. By creating objects 

on different layers, you can edit and view related portions of a 

model separately or as a composite. You can create as many 

layers as you like. 

 

 

To create a new layer: 
1 From the Edit menu click Layers, and then click Edit Layers. 
2 In the Layers panel, click the New icon. 
3 The new layer, Layer 06, appears in the list. Type Lines and 

press Tab. 

 

 
 

To assign a color to a layer: 
1 Click the square Color patch on the Lines row in the list. 
2 In the Select Color dialog box, click Red from the list. 

The right half of the sample rectangle turns red. 
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To make a layer current: 
1 In the Status Bar, click the Layer pane. 

2 In the Layer popup, click Lines. 
The current layer is displayed in the Layer pane. 
3 Draw some lines. 
The lines are on the Lines layer and they are colored red. 
4 To make a different layer current, click the Layer pane again. 
5 Click Curves. 
6 Draw some curves. 
They are on the Curves layer and are colored blue. 

7 Draw more lines and curves on each layer. 

Drawing with precision 
Circles 
You can create circles using a center point and radius, center 
point and a diameter, two points on the diameter, three points on 
the circumference, and tangent points to two coplanar curves and 
a radius. 
 
    

Circle Draw a circle using the center and radius. 
Circle 3Point Draw a circle through three points on its 
circumference 
Circle Diameter Draw a circle using two diameter points. 
Circle Tangent, 
Tangent, Radius 
Draw a circle tangent to two curves with a given radius. 
Circle Tangent to 3 
Curves 
Draw a circle tangent to three curves. 
Deformable Draws an approximation of a circle with a defined 

number of control points.. 
Circle Around Curve Draw a circle perpendicular to a curve at the 
chosen point. Vertical Draw a circle perpendicular to the 
construction plane. 
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To draw a center, radius circle: 

 
1 From the Curve menu click Circle, and then click Center, 
Radius. 
                                                                                                                                                                                                                        
2 For the Center of circle snap to the intersection of the 
centerlines. 
3 For the Radius type 4 and press Enter. 

A circle is created around the centerline intersection. 

 

 

                              P1 

 

                                     P1         p2         

To draw a diameter circle: 
1 Turn On the Point osnap.                            P1                p2   

2 From the Curve menu click Circle, 
and then click 2 Points. 
3 For the Start of diameter pick snap                                                 
p2 
to the second point from the left end 
of the line you divided. 
4 For the End of diameter type 4 and 
press Enter, then turn Ortho on and 

pick in the straight up direction. 
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To draw a tangent, tangent, radius circle: 
1 From the Curve menu click Circle, 
and then click Tangent, Tangent, 
Radius. 
2 For the First tangent curve, select 
the top line.                                         P1 
3 For the Second tangent curve,                                   
select the left line. 
4 For the Radius, type 2 and press                 p2 
Enter. 
A circle is created that is tangent to 

the two lines  .                 

                     

                                          

                                                                                                  
To draw a rectangle from diagonal corners:                                         

1 From the Curve menu click Rectangle, and then click Corner to corner 
                                                                                             

2 For the First Corner, type -10,-5 and press Enter                        

3 For the Length, type 20 and press Enter. 

4 For the Width, type 10 and press Enter                                                 L          

                     P1                                                                                                                                                                                                                                        
                     .                                                                                                                           

                 L=20                                                                                                             

                                                                                                                        

                                                                   P2                                                                                 

                                     W=10 
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To draw a polygon from its center and radius: 
1 From the Curve menu click Polygon, and then click Center, 
Radius. 
2 Click NumSides on the command line, type 3 and press Enter 
to change 
the number of sides for the polygon.                                                                     
Radius=3 
3 For the Center, type -7,-2 and press Enter to locate the 
center point for 

the polygon. 
4 For the Corner, type 1.5, and press Enter. 
5 Pick a point to orient the polygon. 
6 Make a six sides polygon. 
 

                             

                      R=1.2 

 

 

To make the rectangle solid: 

1 Select the rectangle. 
2 From the Solid menu click Extrude Planar Curve, and then 
click          
Straight. 
3 Set the Bothsides option to No. 

4 Drag it up to set the thickness and click. 

 

 

                  H=5 

                                         L=10 
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To make the curve into a surface:                                                                           
1 Select the control point curve.                                                                                 
2 From the Surface menu click 
Revolve. 
3 For the Start of revolve axis, snap 
either end of the curve. 
4 For the End of revolve axis, snap to 
the other end of the curve. 
5 For the Start angle, click FullCircle. 
6 Repeat steps 2-5 for the interpolated 

                                                                          

Edit and Modify the Shape 
Once you create objects, you can move and edit them to produce 
complex and detailed variations. 
Fillet 
Fillet connects two lines, arcs, circles, or curves extending or 
trimming them to touch or to join with a circular arc. 
Rules to follow when filleting curves:  
• The curves must be coplanar. 

• The created fillet is determined by picking on the curve portion 
to keep. 
• The radius cannot be so large that it runs past the end of the 
curve. 
                                          

Option Description 

Radius Sets the fillet radius. A radius of 0 extends or trims the 
curves to a corner, but does not create a fillet. 
Join Yes, joins the fillet to the curves. 
No, does not join the fillet to the curves. 

Trim Yes, trims the curves to the fillet arc. 

No, does not trim the curves                                          

.  
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To fillet lines using an arc: 
 

 

1 From the Curve menu click Fillet Curves. 
 
2 Type 2 and press Enter to change the radius. 
 
This is another method to change the radius. 
 

3 Click Join to change the Join option to Yes. 
 
This option joins the curves as they are filleted. 
4 Select an outer vertical line 
. 
5 Select an adjacent horizontal line. 
 
The ends of the lines are trimmed to a radius 
 
6 Press Enter to repeat the command 
 

7 Fillet the other corners as shown.           

 
                                     

                2CM 

 
 

               

                                              2cm                                     
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T 

Chamfer 
Chamfer connects two curves by extending or trimming them to intersect or 

to join with a beveled line. Chamfer 

works on convergent or intersecting curves. 

� Open the model Chamfer.3dm.                                    

To chamfer lines: 
1 From the Curve menu click Chamfer Curves .                     

                                                              

2 For the Select first curve to 
Chamfe r, type 1,1 and press Enter, 

to set the distances. 
 
 
 

 
 
1cm 
 
 
 
1cm 

 

 
 
 
 
 
 

 
 
 

                            
Move 
Use Move to move objects without changing orientation 

or size. 
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1 Open the model Move. 

2 Turn off both Ortho and Grid Snap so you can move 

objects freely. 

3 Turn Cen object snap on. 

 

Copy     
Copy duplicates selected objects and places them in a new 

location. The command can repeat to create more than one copy 

in the same command sequence. 

 
 

To copy using object snaps for placement: 
1 Select the small circle at the lower left of the object. 
2 From the Transform menu click Copy. 
3 For the Point to copy from, snap to the center of the small 
circle. 
4 For the Point to copy to, snap to the center of the arc at the 

upper left of the object. 
 

5 Pick to place the object, and press Enter. 

 

Rotate 

Use Rotate to move objects in a circular motion around a base 

point. For precise rotation, enter a number of degrees to rotate. 

Positive numbers rotate counterclockwise; negative numbers 

rotate clockwise. 
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Group 
Grouping objects allows all members of the group to be selected 

as one. You can then apply commands to the entire group. 

 
1 Select the two circles that you placed. 

2 From the Edit menu click Groups, and then click Group. 

Mirror 
Mirror creates a copy of the objects flipped over a specified axis 1 
Select the group. 
2 From the Transform menu click Mirror. 
3 For the Start of Mirror plane type 0,0 
or snap to the end of the line at the lower right of the part. 
 
4 Toggle Ortho on and pick directly above 
the previous point.Click first axis p1 then click second axis p2. 

on the construction plane. 

                                    P2 

 

 

 

 

                                    P1 

 

Join 
 

Join unites curves that meet at a common end, making a single 

curve. Join can unite curves that do not touch, if you select them 

after the command has started. As you select non-touching 

curves, a dialog box asks if you want to fill the gap.   
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Join 
1 Select the two polylines. 

2 From the Edit menu click Join. 

3 Click first line then click second line. 

 

 

        Before                                                                       AFTER 

 

Scale 
Scale changes the size of existing objects without changing their 
shape. This command scales three-dimensional 
objects equally along all three axes. There are also 2-
dimensional, one-dimensional, and non-uniform scale. 
 

—Scaling objects 

 

 
1 From the Edit menu click Select Objects, and then click 
Curves. 
 
2 From the Transform menu click Scale, and then click Scale 2-
D . 

ommands. 
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3 For the Origin point, type 0 and press Enter. 
 

4 For the Scale factor, type .75 and press Enter. 
 

5 Select small object and drag the mouse. 
 
The whole part scaled to 75 percent of its original size.  

 

 

 

 

 

  Before scaled        After scaled 

 

 

Extend 
Extend lengthens an object to make it end precisely at its 
intersection with another object or you can lengthen an 
object when there is no intersection. 
—Extend 
1 Open the model Extend.3dm. 
2 From the Curve menu click Extend Curve, and then click 
Extend Curve. 
3 For the Select boundary objects, select the line at the left 
and the curve at the right. 

 
4 For the Select curve to extend, click Type=Natural on the 
command line. 

5 Change to Type=Line. 
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            Before extend                            After extend 

Offset 
Offset creates an object parallel or concentric to another object. Use Offset 
to create specialized copies, such as 

parallel lines, concentric circles, and concentric arcs, through specified points 
or at pre-set distances. 

Exercise 48—Offset 
1 Open the model Offset. 

2 Maximize the Top viewport.                                                             
L10CM                                                                               L=10       

3 Select the line. 
4 From the Curve menu click Offset, then click 

Offset Curve. 
5 For the Side to offset, pick on the upper right 

side of the line.                                                                               

A parallel line is created.                                                     L=10                                                    

 

To offset a polyline with sharp corners: 

1 Select the polyline. 
2 From the Curve menu click Offset, then click Offset Curve. 

3 Type 1 and press Enter to change the offset distance. 
4 For the Side to offset, pick inside the polyline. 

The polyline is offset with sharp corners. 
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Array 
Use the Array commands to make multiple copies of 

selected objects. Array Rectangular makes rows and 

columns 

of objects. Array Polar copies objects in a circle around a 

center point 

Exercise 49—Polar Array 

To create a polar array: 

1 Open the model Array.3dm. 

2 Select the small circle in the Top viewport. 

3 From the Transform menu click Array, and THEN 

CLICK POLOR .      
                                                                                                                  

 

then click Polar.                                                                                             
4 For the Center of polar array, snap to the 
center of the large circle. 
5 For the Number of items, type 10 and press 
Enter. 
6 For the Angle to fill, check to see if it is set to 
360, press Enter. 

The small circle is arrayed                                                                                                                                                   
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3D COMMANDS AND THEIR USES 

Button Command Description 
Box= Draw a rectangular box from two diagonal corners and a 
height. 
Box 3Point =Draw a box from two adjacent corners, a point on 
the edge across from them, and a height. 
Sphere = Draw a sphere from a center point and a radius. 
Sphere 2Point= Draw a sphere from the two ends of a diameter. 
Sphere 3Point= Draw a sphere from three points on its surface. 
Cylinder= Draw a solid cylinder from a center point, a radius, and 

a height. 
Tube= Draw a solid tube from a center point, two radii, and a 
height. 
Cone= Draw a solid cone from a base point, a base radius, and a 
height. 
TCone =Draw a truncated cone that ends in a circular plane from 
a base point, two radii, and a height. 
Ellipsoid= Draw an ellipsoid from a center point, and three axis 
endpoints. 
Torus =Draw a solid Torus from a center point, a radius for the 
center of the tube, and a tube radius. 
Pipe= Draw a pipe around an existing curve. The pipe has a 
circular cross-section and optional caps 
at the ends. 
The Thick option lets you specify two radii at each end of the 
curve to create pipes with holes 
bored through the middle like tubing. 
TextObject= Draw text as outline curves, surfaces, or solids. 
ExtrudeCrv= Draw a solid by extruding a closed planar curve 
vertically. 
ExtrudeSrf= Creates a solid by extruding a surface vertically. 
Cap Creates planar surfaces to close planar holes in a surface or 
partial solid. 
BooleanUnion= Boolean operation in Rhino to combine solids. 
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BooleanDifference =Boolean operation in Rhino to subtract 

surfaces and solids from one another. 
BooleanIntersection= Boolean operation in Rhino to create the 
intersection of two surfaces or solids. 
 
 
 
 

HOW TO MAKE 3D MODELS FROM A 2D ? 
 
 
There are some useful command through which you can draw 3d design 

from a 2d . We learn every step of using 3d commands. 

 
 
REVOLVE COMMAND = Here are an image of Flower vase , now 
you learn how to make it. 
 

 
 
1 – Start a 2d drawing of flower vase as (image 1) . 
 

2 – On the Surface menu, click the Revolve option. 
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3 – Select the ( image 1) then click p1 and p2 , it will look as ( image 2) 

press , Enter. 
 

4 – Now you can see final ( image 3). 

 
 

RAIL REVOLVE COMMAND = Here are some images of star , 

now you can how to make it . 
 
 

     
 
         Image 1                           Image 2                         Image 3 

 

 
 
1 – Start a 2d drawing of STAR as (Image 1) 

 

2 – Draw a curve  on the star as showed ( image 2 ) the Red line and Yellow 

line is a extra curve to applied the command .  

 

3 – On the Surface menu, click Rail Revolve option. 

 

4 – Select red line on the star . Select star then click first point an end point 

of the yellow line. 

 

Now you can see the final image of STAR as (Image 3). 
 

 
 

 
                                                         28 



 

SWEEP 1 RAIL COMMAND = Here is an image of Pipe that has 2 

different shape , now you will learn how to make it. 
 

                                                                     
                                                   

 
 

1 – Start a 2d drawing of Pipe as showed image above . 

 

2 – On the Surface menu , click the Sweep 1 RAIL. 

 

3 – Select the curve, then select both the curve press Enter . 

 

 
 

 
 

SWEEP 2 RAIL COMMAND = To make a Bottle , we use sweep 2 rail 

command .  
 

 

1 – On the Surface menu , click sweep 2 rail curve . 
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2 – Select both green curve and select both red curve , press Enter.(image 

1) 

 

  
 
               Image 1                                         Image 2                               

    
 

3 – Now the half image is ready of Bottle . Make mirror of the half 
object , it would be a Bottle after mirror . 
 
 
 
 

LOFT COMMAND = Loft command is used to make 3d from many 

different types of shape . You can see an image given bellow . 
 
 
 
 

 

1 – On the Surface menu , click the LOFT option. 

 

2 – Draw a 2d to make Loft object as shown the image. 
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3 – Select 2d , press Enter . 
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You Annotating your model 
Rhino can also produce 2D drawings of your models. 

Rhino has these annotation objects: 
• Dimensions 

• Annotation Text 

• Leaders 

• Dots 

• Hatching 

Dimensions 
can create dimensions on all viewports. They will 
be created parallel to the current viewport’s 

Cplane. 
Dimension commands are combined with object 
snaps to give precise values. There are many 

different types of 
dimensions that are used to annotate a model. We 
will look at linear, radial, diameter, and angular. 
 

 
2-D annotation text, Leaders, and Dots will also be 
covered. 

The dimension style controls the way a dimension 
displays. For example the dimension text location 
can be above 

the dimension line or in the dimension line. The 
end of a dimension line can display an arrow, a 
tick, or a dot.  
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  The dimension text can show decimal, fractional, 
or feet and inches numbers. A new model will open 

with Default as the dimension style. 
 
You can make additional dimension styles, assign 
existing dimensions to a different style, or update 

a style to 
make all the dimensions assigned to that style 
update. You can also import a dimension style 

from another model. 
Or add the dimension style to a template so new 
models always have it. 

Let’s look at the dimension types: 
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Dimension tools 

 
Button Command Description 

Dim Linear Dimension- creates a horizontal or 
a vertical dimension. 

DimAligned - Creates an aligned dimension. 

DimRotated - Creates a rotated dimension. 
DimAngle -Creates an angular dimension. 

DimRadius - Creates a radius dimension. 
DimDiameter- Creates a diameter dimension. 
Text Creates 2-D annotation text. 
Leader Draw an arrow leader. 

 

 

 

 

 

 Rendering 
Rendering is available for showing your model as if it was 
photographed or sketched. If you render to look like a 
photo, this is called photorealistic rendering. Flamingo nXt is an 
example of a photorealistic render plug-in for RHINO. 
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   If you render to look hand sketched, this is called non-

photorealistic. Penguin is an example of this type of 

render. 
Both types of renderers are available as plug-ins for Rhino. The 
built-in Rhino renderer may be good enough for 
much of your work. If not, use another rendering program such 
as Flamingo nXt, V-Ray, Maxwell, Brazil or other 
plug-ins for higher quality results. Plug-ins for Rhino are listed on 
the Resources page of the Rhino web site. 
                                                                            

Apply materials 
Rhino’s built-in renderer uses materials with color, gloss 

and transparency settings, spotlights, displays shadows, 

and does antialiasing. It also allows the attachment of 

textures and bump maps. In this exercise we will focus 

on the full rendering capability. 
                                                                       

Practice rendering a model 
1 Open the model Render. 
2 From the Render menu click Current Renderer, and then 
click Rhino 
Render. 
3 Right click on the Perspective title bar, and then click 
Rendered display. 
The viewport mimics but does not exactly duplicate what you will 
get in 
a Render. 
                                                     

To assign a material to the handle by object: 
To render the handle in color, we will first assign a red glossy 
material to the handle object. This material assigned 
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to the object will override any material that might be assigned to 

the layer of the object. 
                                                 
1 Select the handle. 
2 In the Properties panel, click on the Material page. 
 
 
 

  

      3 On the Material page box, at Assigned 

material by: choose Object. 

4 From the Material page, in the name field type Red_glossy. 
                                                 

5 Next click the Color 

swatch. 
6 In the Select Color dialog 

box, select a color, like 
Red, and click OK. 

To give the handle a 
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highlight, change the 

 
                                            

Gloss finish setting  

 

.  

 

 

 

 

 

 

 

 

 

                                                                                

 

                         

                                                                 37 



Printing and Layouts 
Printing 

The Rhino Print command will let you print one viewport 

at a time. 

Printing the model 

1 Open the model Dimension.3dm. 

2 Make the Top viewport active and from the File 

menu click Print. 

3 In the Print Setup Destination dialog, select 

a printer, Letter Size paper, Landscape 

orientation, Raster Output, and Display 

4 In the View and Output Scale area, select 

Scale of 2:1, On Paper 1.0 Millimeter, and 

In Model 0.5 Millimeter. 
 

                                                                       

 

Rhino will print .5 mm of the model in every 1 

mm on the printed sheet. 
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